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Introduction 

The OI BRWDesigner application is a tool used for creating and editing OI BRW report 
definition files.  

Create	New	Reports	

Use the OI BRW Wizard to quickly and easily create a new report. 

1. Select the data source for the new report 
2. Select the fields you want to include in the report 
3. Set the layout, style and title for the new report 

Design	and	Modify	Reports	

The Access-style WYSIWYG design surface makes designing reports easy and 
intuitive. Drag and drop report fields from the toolbar onto the report's design surface. 
Banded regions mark each area of the report such as header, body and footer. Set all 
field related properties directly in the application itself. You can even write custom 
VBScript code from the Properties window. 

Export	Reports	

Directly export a report to any of the supported file formats: HTML, PDF, RTF, XLS, 
XLSX, TIF, TXT or ZIP. 
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Creating a Quick Report using the OI BRW 
 
From the OpenInsight Application Manager, Application Tools, choose OI BRW… 
 

 
 
Once the OI BRW launches make sure that you choose the Report View (Re) from the bottom left panel.  This will 
allow you to choose an existing report or create a new report. 
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Click the New Report tab to create a new report.  This will launch the BRWDesigner Wizard. 
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Your OpenInsight tables attached to your application will be displayed.  Select the table for use with your new 
report and click Next. 
 

 
 
The OpenInsight dictionary fields for your selected table will be displayed.  Select the fields that you want to be 
included in your report and click Next. 
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Select your report layout and click Next. 
 

 
 
Select your report style and click Next. 
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Enter your report title, select Preview the Report and click Finish. 
 

 
 
Your completed report will display in the Print Preview window. 
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Click the Close Print Preview button to return to Design mode. 
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Working with OI BRW 
You can use OI BRW in many different scenarios, on the desktop and on the Web. The main sequence of steps is 
always the same: 

1. You start by creating a report using the OI BRWDesigner application to create report definitions 
2. The OI BRW component reads the report definitions and renders the reports using data from your 

OpenInsight system. 
3. Reports can be rendered directly to a printer, or into HTML and PDF files that can be published on the Web. 

The following diagram shows the relationship between the components in the ComponentOne Reports for 
WinForms package (used by the OI BRWDesigner): 
Note: Boxes with a bold border represent code components (controls and applications). Boxes with a thin border 
represent files containing information (report definitions, data, and finished reports).  

 
The following numbers refer to the numbered arrows in the image, indicating relationships between the 
components: 

1. Use the OI BRWDesigner application to create, edit, and save report definition files. 
2. The OI BRW component loads report definitions from the files created with the Designer. This can be done 

at design time (in this case the XML file is persisted with the control and not needed at run time) or at run 
time using the Load method. 

3. The OI BRW component loads data from the OpenInsight data source specified in the report definition file. 
4. The OI BRW component formats the data according to the report definition and renders reports to a (a) 

printer, (b) to one of several file formats, or (c) to a print preview control. 

 
Object Model Summary 

Sections of a Report 

Developing Reports for Desktop Scenarios 

Developing Reports for Web Scenarios 

Creating, Loading, and Rendering the Report 

Grouping and Sorting Data 

Working with VBScript 

Using Event Properties 

Advanced Uses 
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Object Model Summary 
The object model for the OI BRW component is largely based on the Microsoft Access model, except that Access 
has different types of controls (label control, textbox control, line control, and so on), while OI BRW has a single 
Field object with properties that can make it look like a label, textbox, line, picture, subreport, and so on. 
The following table lists all objects, along with their main properties and methods (note that OI BRW uses twips for 
all measurements. One twip is 1/20 point, so 72 points = 1440 twips = 1 inch): 

OI BRW Object: the main component 

ReportName, GetReportInfo, Load, Save, Clear, Render, RenderToFile, RenderToStream, PageImages, 
Document, DoEvents, IsBusy, Cancel, Page, MaxPages, Font, OnOpen, OnClose, OnNoData, OnPage, 
OnError, Evaluate, Execute 

Layout Object: determines how the report will be rendered on the page 

Width, MarginLeft, MarginTop, MarginRight, MarginBottom, PaperSize, Orientation, Columns, 
ColumnLayout, PageHeader, PageFooter, Picture, PictureAlign, PictureShow 

DataSource Object: manages the data source 

ConnectionString, RecordSource, Filter, MaxRecords, Recordset 

Groups Collection: a report may have many groups 

Group Object: controls data sorting and grouping 

Name, GroupBy, Sort, KeepTogether, SectionHeader, SectionFooter, Move 

Sections Collection: all reports have at least 5 sections 

Section Object: contains Field objects (also known as "report band") 

Name, Type, Visible, BackColor, OnFormat, OnPrint, Height, CanGrow, CanShrink, Repeat, 
KeepTogether, ForcePageBreak 

Fields Collection: a report usually has many Fields 

Field Object: a rectangular area within a section where information is displayed 

Name, Section, Text, TextDirection, Calculated, Value, Format, Align, WordWrap, Visible, Left, Top, 
Width, Height, CanGrow, CanShrink, Font, BackColor, ForeColor, BorderColor, BorderStyle, LineSlant, 
LineWidth, MarginLeft, MarginRight, MarginTop, MarginBottom, LineSpacing, ForcePageBreak, 
HideDuplicates, RunningSum, Picture, PictureAlign, Subreport, CheckBox, RTF 

 
Sections of a Report 
Every report has at least the following five sections: 

Section Description 

Detail The Detail section contains fields that are rendered once for each record in the 
source recordset. 

Header The Report Header section is rendered at the beginning of the report. 

Footer The Report Footer section is rendered at the end of the report. 

Page Header The Page Header section is rendered at the top of every page (except optionally 
for pages that contain the Report Header). 

Page Footer The Page Footer section is rendered at the bottom of every page (except optionally 
for pages that contain the Report Footer). 

In addition to these five sections, there are two additional sections for each group: a Group Header and a Group 
Footer Section. For example, a report with 3 grouping levels will have 11 sections. 
Note that sections can be made invisible, but they cannot be added or removed, except by adding or removing 
groups. 
The following diagram shows how each section is rendered on a typical report: 
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Report Header 

The first section rendered is the Report Header. This section usually contains information that identifies the report. 

Page Header 

After the Report Header comes the Page Header. If the report has no groups, this section usually contains labels 
that describe the fields in the Detail Section. 

Group Headers and Group Footers 

The next sections are the Group Headers, Detail, and Group Footers. These are the sections that contain the actual 
report data. Group Headers and Footers often contain aggregate functions such as group totals, percentages, 
maximum and minimum values, and so on. Group Headers and Footers are inserted whenever the value of the 
expression specified by the GroupBy property changes from one record to the next. 

Detail 

The Detail section contains data for each record. It is possible to hide this section by setting its Visible property to 
False, and display only Group Headers and Footers. This is a good way to create summary reports. 

Page Footer 

At the bottom of each page is the Page Footer Section. This section usually contains information such as the page 
number, total number of pages in the report, and/or the date the report was printed. 

Report Footer 

Finally, the Report Footer section is printed before the last page footer. This section is often used to display 
summary information about the entire report. 

Customized sections 

You can determine whether or not a section is visible by setting its Visible property to True or False. Group 
Headers can be repeated at the top of every page (whether or not it is the beginning of a group) by setting their 
Repeat property to True. Page Headers and Footers can be removed from pages that contain the Report Header 
and Footer sections by setting the PageHeader and PageFooter properties on the Layout object. 
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Grouping and Sorting Data 
This section shows how you can organize the data in your report by grouping and sorting data, using running 
sums, and creating aggregate expressions.  

 
Grouping Data 

Sorting Data 

Adding Running Sums 

Adding Subtotals and Other Aggregates 

Creating Cross-Tab Reports 
 

Grouping	Data	
After designing the basic layout, you may decide that grouping the records by certain fields or other criteria would 
make the report easier to read. Grouping allows you to separate groups of records visually and display introductory 
and summary data for each group. The group break is based on a grouping expression. This expression is usually 
based on one or more recordset fields but it can be as complex as you like.  
You can group the data in your reports using the OI BRWDesigner application or using code: 

•Adding grouping and sorting using OI BRWDesigner  
 
 Groups are also used for sorting the data, even if you don't plan to show the Group Header and Footer 

sections. You can add groups to your report using the OI BRWDesigner application. 

 
To add or edit the groups in the report, complete the following steps: 
1. Open the OI BRWDesigner application.  
2. Click the Sorting and Grouping button on the Design tab in the Data group.  

The Sorting and Grouping dialog box appears. You can use this dialog box to create, edit, reorder, 
and delete groups. 

3. To create a group, click the Add button and set the properties for the new group. 
The Group By field defines how the records will be grouped in the report. For simple grouping, you 
can select fields directly from the drop-down list. For more complex grouping, you can type grouping 
expressions. For example, you could use State to group by State . 

4. To follow along with this report, select City for the Group By expression. 
5. Next, select the type of sorting you want (Ascending in this example). You can also specify whether 

the new group will have visible Header and Footer sections, and whether the group should be 
rendered together on a page. 

 
Here's what the Sorting and Grouping dialog box should look like at this point: 
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If you add more fields, you can change their order using the arrow buttons on the right of the Groups list. 
This automatically adjusts the position of the Group Header and Footer sections in the report. To delete a 
field, use the Delete button. 
Once you are done arranging the fields, click OK to dismiss the dialog box and see the changes in the 
Designer. There are two new sections, a Header and Footer for the new group. Both have height zero at 
this point, you can expand them by dragging the edges with the mouse. Notice that the Group Header 
section is visible, and the footer is not. This is because the Group Header button in the dialog box has 
been checked, and the Group Footer button was left unchecked. Invisible sections are displayed with a 
hatch pattern to indicate they are invisible. 

 
On the tan bars that mark the top of the new sections there are labels that contain the section name and 
the value of the group's GroupBy property. 
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Sorting	Data	
You can sort data in reports the following two ways: 

•Sort the data source object itself (for example, using an R/Lit statement with a BY clause). 
•Add groups to the report and specify how each group should be sorted using the group's GroupBy and Sort 

properties. 
Group sorting is done using the DataView.Sort property, which takes a list of column names only (not expressions 
on column names). So if your grouping expression is DatePart("yyyy", dateColumn), the control will actually sort 
on the dates in the dateColumn field, not on the years of those dates as most would expect. 
To sort based on the dates, add a calculated column to the data table (by adding a calculated column to the 
underlying Openinsight table), and then group/sort on the calculated column instead. See the Sort property for an 
XML discussion of this, including a sample. 
This is what the Sorting and Grouping editor looks like in the OI BRWDesigner application. Note the fields 
where you can specify group sorting: 

 
If you use both approaches, the sorting set in the report groups will prevail (it is applied after the data has been 
retrieved from the database). 
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Adding	Running	Sums	
OI BRW field objects have a RunningSum property that makes it easy to maintain running sums over groups or 
over the entire report. The RunningSum property can be seen in a field’s property panel, in the Data section, as 
seen below. 

 

Adding Running Sums over a Group 

To keep running sums over groups, complete the following tasks: 
1. Open the OI BRWDesigner application. 
2. Create a new report or open an existing report. Once you have the report in the OI BRWDesigner 

application, you can modify the report properties. 
3. Click the Design button to begin editing the report. 
4. In Design mode, select the report from the drop-down list above the Properties window. The available 

properties for the report appear. 
5. Add a calculated field to the report: 

a. Click the Add Calculated Field button from the Designer toolbar. 
b. In the VBScript Editor, enter the following script (be sure to use the Database field, not Report field): 

Sum(Invoice_Total) 

c. Drag the mouse over the GroupHeader section of the report and the cursor changes into a cross-hair 

. Click and drag to define the rectangle that the new field will occupy, and then release the button 
to create the new field. 

6. Set the RunningSum property to SumOverGroup. (Note that for this property to appear, the properties 
filter must be turned off. It's the funnel icon above the Properties window.) 

Adding Running Sums over the Entire Report 

To keep running sums over pages, you need to use script. For example, you could add a pageSum field to the 
report and update it with script. To do this, complete the following tasks: 

1. Open the OI BRWDesigner application. 
2. Create a new report or open an existing report. Once you have the report in the OI BRWDesigner 

application, you can modify the report properties. 
3. Click the Design button to begin editing the report. 
4. In Design mode, select the report from the drop-down list above the Properties window. The available 

properties for the report appear. 
5. Locate the OnPage property and click the empty field next to it, and then click the ellipsis button. 
6. The VBScript Editor appears. Enter the following VBScript expression in the code editor: 

' VBScript: Report.OnPage 
pageSum = 0 

7. Then select Detail from the drop-down list above the Properties window. The available properties for the 
Detail section appear. 

8. Locate the OnPrint property and click the empty field next to it, and then click the ellipsis button. 
9. The VBScript Editor appears. Enter the following VBScript expression in the code editor: 

' VBScript: Detail.OnPrint 
pageSum = pageSum + UnitsInStock 
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Adding	Subtotals	and	Other	Aggregates	
OI BRW supports aggregate expressions in all its calculated fields. The aggregate expressions include all the usual 
Sum, Avg, Min, Max, Count, Range, StDev, and so on. 
A Calculated field can be added to a report by clicking on the Calculated Column icon in the Fields tab, as seen 
below: 

 
Once the icon is clicked, the script editor window appears. Clicking on the Fields button causes menus to appear. 

 
All aggregate functions take an expression as an argument and evaluate it within a scope that is determined by 
their position in the report. For example, aggregates in group headers or footers have the scope of the group. 
Aggregates in the report header or footer have the scope of the entire report. 
For example, the following aggregate expression would return the sum of all values in the Invoice_Total field for 
the scope of the aggregate (group or report): 

Sum(Invoice_Total) 

The following aggregate expression would return the total amount of sales taxes paid for all values in the report 
(assuming an 8.5% sales tax): 

Sum(Invoice_Total * 0.085) 

You can reduce the scope of any aggregate using a second argument called domain. The domain argument is an 
expression that determines whether each value in the current scope should be included in the aggregate 
calculation. 
For example, the following aggregate expression would return the sum of all values in the Invoice_Total field for 
products in category 1: 

Sum(Invoice_Total, Category = 1) 

The following aggregate expression would return the number of sales over $10,000: 
Count(*, Invoice_Total > 10000) 
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Counting	items	in	a	Group	or	Report	
In certain cases you will want to get a running number of items in a group, or over an entire report 

1. In the BRW designer, create a calculated field, and in the script editor just put in "1" as the expression 
(not in quotes - just the number 1); 
2. Draw in the calculated field wherever you want the incrementing counter to go on the report; 
3. In the properties for that calculated field, set the "RunningSum" property to "SumOverGroup"
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Selecting Rows 
A report rarely ever wants to display all the records in a table. Usually, users require a subset of the data in the 
report, based upon some selection criteria. The OI BRW allows such functionality. 
 
With the report in design mode, click on the property pane for the whole report, as seen below.  This can be done 
by clicking on the section Selector, and choosing the name of the report. 

 

   
 
Expand the ‘DataSource’ section by clicking the ‘+’ and see the ‘Filter’ option, with the button with an ellipsis on it. 
 

  
 
Clicking on that button will bring up the BRW Script editor window. 
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In this window, by clicking on the “Fields >>” button, the user can choose from either list of database fields and 
operators and build the select statement for the report.  
 

 
 
In the image below, we’ve already chosen the selection keyword “WITH’, and then chosen the database field 
‘AUTHOR’, and are about to select the operator for ‘Containing’ 
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We’ll complete our selection criteria by searching on Author containing the word “TWAIN” and press the OK button.  
At this point, the property pane for the report shows the filter we have specified.  
 

 
 
Running the report at this point gives us a list of all books whose author contains the work “Twain”. 
 
The select statement may also be entered in manually, rather than building it using the “Fields>>” button. 
 
Specifying MaxRecords with a value greater than zero will limit the number of records returned to the value 
entered. 
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OpenInsight 9.3.1 and above includes the following enhancements: 
 

 When specifying a filter with a prompt (WITH AUTHOR [] “?Enter Author Name?”), if the same prompt is 
specified more than one time in the filter, the user is not re-prompted – the already-entered value is 
repeated. 

 When specifying a filter with a prompt, it is now possible to specify the default response – use a pipe, and 
then the suggested default (WITH AUTHOR [] “?Enter Author Name|Twain?”). 

 A user-specified function can now be called to generate the list of matching IDs – specify  
CALL <functionname> (and then any other optional selection filter, including prompted values), and 
<functioname> will be called – we expect a list of IDs (@FM delimited) as the response to the call.  For 
example: 

CALL SELECTME WITH AUTHOR [] “?Enter Author Name|Twain?” 
Will show the prompt “Enter Author Name” with the default value of Twain, and then we will senf to the 
function SELECTME, as parameter #1, the string WITH AUTHOR [] “Dickens” (if the user entered Dickens).  
If this was a test run of 10 records, then parameter#1 will be 10 WITH AUTHOR [] “Dickens” 
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Working with VBScript 
VBScript expressions are widely used throughout a report definition to retrieve, calculate, display, group, sort, 
filter, parameterize, and format the contents of a report. Some expressions are created for you automatically (for 
example, when you drag a field from the Toolbox onto a section of your report, an expression that retrieves the 
value of that field is displayed in the text box). However, in most cases, you create your own expressions to 
provide more functionality to your report.  
Note the following differences between VBScript expressions and statements: 

•Expressions return values, you can assign them to things like Field.Text, for example:  
Field1.Calculated = true 
Field1.Text = "iif( 1=1, 1+2, 1+3 )" 

•Statements don't return values. You can assign them to event properties like OnFormat. For example: 
c1r.OnOpen = "if 1=1 then msgbox("OK!!!") else msgbox("ooops")" 

OI BRW relies on VBScript to evaluate expressions in calculated fields and to handle report events. 
VBScript is a full-featured language, and you have access to all its methods and functions when writing OI BRW 
expressions. For the intrinsic features of the VBScript language, refer to the Microsoft Developer's Network 
(MSDN). 
OI BRW extends VBScript by exposing additional objects, variables, and functions. These extensions are described 
in the following sections. 

 
VBScript Elements, Objects, and Variables 

Using Compatibility Functions: Iif and Format 

Using Aggregate Functions 
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VBScript	Elements,	Objects,	and	Variables	
The following tables detail VBScript elements, objects, and variables. 

Operators 

The following table contains the VBScript operators: 

Operator Description 

And Performs a logical conjunction on two expressions. 

Or Performs a logical disjunction on two expressions. 

Not Performs a logical disjunction on two expressions. 

Mod Divides two numbers and returns only the remainder. 

Reserved symbols 

The following table contains the VBScript reserved symbols and how to use them: 

Keyword Description 

True The True keyword has a value equal to -1. 

False The False keyword has a value equal to 0. 

Nothing Used to disassociate an object variable from any actual object. To 
assign Nothing to an object variable, use the Set statement, for 
example: 
Set MyObject = Nothing  

Several object variables can refer to the same actual object. 
When Nothing is assigned to an object variable, that variable no 
longer refers to any actual object. When several object variables 
refer to the same object, memory and system resources 
associated with the object to which the variables refer are 
released only after all of them have been set to Nothing, either 
explicitly using Set, or implicitly after the last object variable set 
to Nothing. 

Null The Null keyword is used to indicate that a variable contains no 
valid data.  

vbCr When you call print and display functions, you can use the 
following constants in your code in place of the actual values.  

vbCrLf When you call print and display functions, you can use the 
following constants in your code in place of the actual values.  

vbLf When you call print and display functions, you can use the 
following constants in your code in place of the actual values.  

vbFormFeed When you call print and display functions, you can use the 
following constants in your code in place of the actual values.  

vbNewLine When you call print and display functions, you can use the 
following constants in your code in place of the actual values.  

vbNullChar When you call print and display functions, you can use the 
following constants in your code in place of the actual values.  

vbTab When you call print and display functions, you can use the 
following constants in your code in place of the actual values.  

vbVerticalTab When you call print and display functions, you can use the 
following constants in your code in place of the actual values.  

vbBlack Black. Value = 0x0. 

vbRed Red. Value = 0xFF. 

vbGreen Green. Value = 0xFF00. 
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vbYellow Yellow. Value = 0xFFFF. 

vbBlue Blue. Value = 0xFF0000. 

vbMagenta Magenta. Value = 0xFF00FF. 

vbCyan Cyan. Value = 0xFFFF00. 

vbWhite White. Value = 0xFFFFFF. 

Built-in functions 

The VBScript built-in functions are listed below: 

Abs Date Iif Minute Sign 

Acos DateAdd InputBox Month Space 

Asc DateDiff InStr MonthName Sqr 

Asin DatePart InStrRev MsgBox StrComp 

Atn DateSerial Int Now String 

CBool DateValue IsDate Oct Tan 

CByte Day IsEmpty Pi Time 

CCur Exp IsNull Replace Timer 

CDate Fix IsNumeric RGB TimeSerial 

CDbl Format IsObject Right TimeValue 

Chr FormatCurrency LCase Rnd Trim 

CInt FormatDateTime Left Round TypeName 

CLng FormatNumber Len RTrim UCase 

Cos FormatPercent Log Second WeekDay 

CSng Hex LTrim Sgn WeekDayName 

CStr Hour Mid Sin Year 

For more information on the VBScript functions, see the MSDN documentation. Note that the following VBScript 
features are not supported in OI BRW: 

•Arrays 
•Functions/Subs 
•Select/Case statements 

Also note that the following OI BRW features are not part of VBScript: 
•Aggregate functions (Sum, Average, StDev, Var, Count, and so on) 
•Report and Database field names 
•Page/Pages variables 
•Report object  

Statement keywords 

The VBScript statement keywords are listed below: 

If ElseIf To While Dim 

Then EndIf Next Wend Redim 

Else For Step Const 

Report Field Names 

Names of Field objects are evaluated and return a reference to the object, so you can access the field's properties. 
The default property for the Field object is Value, so by itself the field name returns the field's current value. For 
example: 

•Visual Basic 
•C# 
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Note: If you give a report field the same name as a database field, you won't be able to access the report field. 

Report Section Names 

Names of Section objects are evaluated and return a reference to the object, so you can access the section's 
properties. The default property for the Section object is Name. For example: 

•Visual Basic 
•C# 

Database Field Names 

Names of fields in the report's dataset source are evaluated and return the current field value. If a field name 
contains spaces or periods, it must be enclosed in square brackets. For example: 

OrderID 
UnitsInStock 
[Customer.FirstName] 
[Name With Spaces] 

Report Variables 

Page 
The page variable returns or sets the value of the Page property. This property is initialized by the control when it 
starts rendering a report, and is incremented at each page break. You may reset it using code. For example: 

•Visual Basic 
•C# 

Pages 
The pages variable returns a token that gets replaced with the total page count when the report finishes rendering. 
This is a read-only property that is typically used in page header or footer fields. For example: 

•Visual Basic 
•C# 

Report Object 

The report object returns a reference to the control object, so you can access the full OI BRW object model from 
your scripts and expressions. For example: 

•Visual Basic 
•C# 

Cancel 

Set Cancel to True to cancel the report rendering process. For example: 
•Visual Basic 
•C# 

 

Using	Compatibility	Functions:	Iif	and	Format	
To increase compatibility with code written in Visual Basic and Microsoft Access (VBA), OI BRW exposes two 
functions that are not available in VBScript: Iif and Format. 
Iif evaluates a Boolean expression and returns one of two values depending on the result. For example: 

Iif(Invoice_TotalAmount > 1000, "Yes", "No") 

Format converts a value into a string formatted according to instructions contained in a format expression. The 
value may be a number, Boolean, date, or string. The format is a string built using syntax similar to the format 
string used in Visual Basic or VBA. 
The following table describes the syntax used for the format string: 

Value Type Format String Description 

Number Percent, % Formats a number as a percentage, with zero or two decimal 
places.  
For example: 
Format(0.33, "Percent") = "33%" 
Format(0.3333333, "Percent") = "33.33%" 
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#,###.##0 Formats a number using a mask. The following symbols are 
recognized: 
 
# digit placeholder 
0 digit placeholder, force display 
, use thousand separators 
( enclose negative values in parenthesis 
% format as percentage 
 
For example: 
Format(1234.1234, "#,###.##") = "1,234.12" 
Format(-1234, "#.00") = "(1234.12)" 
Format(.1234, "#.##") = ".12" 
Format(.1234, "0.##") = "0.12" 
Format(.3, "#.##%") = "30.00%" 

Currency Currency, $ Formats a number as a currency value. Displays number with 
thousand separator, if appropriate; displays two digits to the 
right of the decimal separator. 
For example: 
Format(1234, "$") = "$1,234.00" 

Boolean Yes/No Returns "Yes" or "No". 

Date Long Date Format(#12/5/1#, "long date") = "December 5, 2001" 

Short Date Format(#12/5/1#, "short date") = "12/5/2001" 

Medium Date Format(#12/5/1#, "medium date") = "05-Dec-01" 

q,m,d,w,yyyy Returns a date part (quarter, month, day of the month, week of 
the year, year).  
For example: 
Format(#12/5/1#, "q") = "4" 

String @@-@@/@@ Formats a string using a mask. The "@" character is a 
placeholder for a single character (or for the whole value string 
if there is a single "@"). Other characters are interpreted as 
literals. 
For example: 
Format("AC55512", "@@-@@/@@") = "AC-555/12" 
Format("AC55512", "@") = "AC55512" 

@;Missing Uses the format string on the left of the semi-colon if the value 
is not null or an empty string, otherwise returns the part on the 
right of the semi-colon.  
For example: 
Format("@;Missing", "UK") = "UK" 
Format("@;Missing", "") = "Missing" 

Note that VBScript has its own built-in formatting functions (FormatNumber, FormatCurrency, FormatPercent, 
FormatDateTime, and so on). You may use them instead of the VBA-style Format function described here. 

 

Using	Aggregate	Functions	
Aggregate functions are used to summarize data over the group being rendered. When used in a report header 
field, these expressions return aggregates over the entire dataset. When used in group headers or footers, they 
return the aggregate for the group. 
All OI BRW aggregate functions take two arguments: 

•A string containing a VBScript expression to be aggregated over the group. 
•An optional string containing a VBScript expression used as a filter (domain aggregate). The filter expression 

is evaluated before each value is aggregated. If the filter returns False, the value is skipped and is not 
included in the aggregate result. 

OI BRW defines the following aggregate functions: 

Function Description 

Avg Average value of the expression within the current group. For example, the 
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following expressions calculate the average sales for the whole group and the 
average sales for a certain type of product: 
Avg(SalesAmount) 
Avg(SalesAmount, ProductType = 3) 

Sum Sum of all values in the group. 

Count Count of records in the group with non-null values. Use an asterisk for the 
expression to include all records. For example, the following expressions count the 
number of employees with valid (non-null) addresses and the total number of 
employees: 
Count(Employees.Address) 
Count(*) 

CountDistinct Count of records in the group with distinct non-null values. 

Min, Max Minimum and maximum values for the expression.  
For example: 
"Min Sale = " & Max(SaleAmount) 

Range Range between minimum and maximum values for the expression. 

StDev, Var Standard deviation and variance of the expression in the current group. The values 
are calculated using the sample (n-1) formulas, as in SQL and Microsoft Excel. 

StDevP, VarP Standard deviation and variance of the expression in the current group. These 
values are calculated using the population (n) formulas, as in SQL and Microsoft 
Excel. 

To use the aggregate functions, add a calculated field to a Header or Footer section, and assign the expression to 
the field's Text property. 
 

 
Using Event Properties 
You are not restricted to using VBScript to evaluate expressions in calculated fields. You can also specify scripts 
that are triggered when the report is rendered, and you can use those to change the formatting of the report.These 
scripts are contained in event properties. An event property is similar to a Visual Basic event handler, except that 
the scripts are executed in the scope of the report rather than in the scope of the application that is displaying the 
report. For example, you could use an event property to set a field's Font and ForeColor properties depending on 
its value. This behavior would then be a part of the report itself, and would be preserved regardless of the 
application used to render it. 
Of course, traditional events are also available, and you should use them to implement behavior that affects the 
application rather than the report. For example, you could write a handler for the StartPage event to update a page 
count in your application, regardless of which particular report is being rendered. 
The following table lists the event properties that are available and typical uses for them: 

Object Property Description 

Report OnOpen Fired when the report starts rendering. Can be used to modify the 
ConnectionString or RecordSource properties, or to initialize VBScript 
variables. 

OnClose Fired when the report finishes rendering. Can be used to perform 
clean-up tasks. 

OnNoData Fired when a report starts rendering but the source recordset is 
empty. You can set the Cancel property to True to prevent the report 
from being generated. You could also show a dialog box to alert the 
user as to the reason why no report is being displayed. 

OnPage Fired when a new page starts. Can be used to set the Visible property 
of sections of fields depending on a set of conditions. The control 
maintains a Page variable that is incremented automatically when a 
new page starts. 

OnError Fired when an error occurs. 

Section OnFormat Fired before the fields in a section are evaluated. At this point, the 
fields in the source recordset reflect the values that will be rendered, 
but the report fields do not. 
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OnPrint Fired before the fields in a section are printed. At this point, the fields 
have already been evaluated and you can do conditional formatting. 

The following topics illustrate typical uses for these properties. 

 
Formatting a Field According to Its Value 

Hiding a Section if There is No Data for It 

Showing or Hiding a Field Depending on a Value 

Prompting Users for Parameters 

Resetting the Page Counter 

Changing a Field's Dimensions to Create a Bar Chart 

 

Formatting	a	Field	According	to	Its	Value	
Formatting a field according to its value is probably the most common use for the OnPrint property. Take for 
example a report that lists order values grouped by product. Instead of using an extra field to display the quantity 
in stock, the report highlights products that are below the reorder level by displaying their name in bold red 
characters.  

To highlight products that are below the reorder level using the OI BRWDesigner: 

Alternatively, instead of writing the code, you can use the OI BRWDesigner application to type the following 
script code directly into the VBScript Editor of the Detail section's OnPrint property. Complete the following steps: 

1. Select Detail from the Properties window drop-down list in the Designer. This reveals the section's available 
properties. 

2. Click the empty box next to the OnPrint property, then click the drop-down arrow, and select Script Editor 
from the list. 

3. In the VBScript Editor, simply type the following script in the window: 
If UnitsInStock < ReorderLevel Then 
  ProductNameCtl.ForeColor = RGB(255,0,0) 
  ProductNameCtl.Font.Bold = True 
Else 
  ProductNameCtl.ForeColor = RGB(0,0,0) 
  ProductNameCtl.Font.Bold = False 
End If 

The control executes the VBScript code whenever the section is about to be printed. The script gets the value of 
the "ReorderLevel" database field and sets the "ProductName" report field's Font.Bold and ForeColor properties 
according to the value. If the product is below reorder level, its name becomes bold and red. 
The following screen capture shows a section of the report with the special effects: 
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Hiding	a	Section	if	There	is	No	Data	for	It	
You can change a report field's format based on its data by specifying an expression for the Detail section's 
OnFormat property. 
For example, your Detail section has fields with an image control and when there is no data for that record's image 
you want to hide the record. To hide the Detail section when there is no data, in this case a record's image, add 
the following script to the Detail section's OnFormat property: 

If isnull(PictureFieldName) Then 
Detail.Visible = False 
Else 
Detail.Visible = True 
End If 

To hide a section if there is no data for it using OI BRWDesigner: 

You can use the OI BRWDesigner application to type the following script code directly into the VBScript Editor of 
the Detail section's OnFormat property. Complete the following steps: 

1. Select Detail from the Properties window drop-down list in the Designer. This reveals the section's available 
properties. 

2. Click the empty box next to the OnFormat property, then click the drop-down arrow, and select Script 
Editor from the list. 

3. In the VBScript Editor: 
•Simply type the following script in the window: 

If isnull(PictureFieldName) Then 
Detail.Visible = False 
Else 
Detail.Visible = True 
End If 

•Or you could use the more concise version: 
Detail.Visible = not isnull(PictureFieldName) 
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Showing	or	Hiding	a	Field	Depending	on	a	Value	
Instead of changing the field format to highlight its contents, you could set another field's Visible property to True 
or False to create special effects. For example, if you created a new field called "BoxCtl" and formatted it to look 
like a bold rectangle around the product name, then you could change the script as follows: 

If UnitsInStock < ReorderLevel Then  
BoxCtl.Visible = True 
Else 
BoxCtl.Visible = False 
End If 

To highlight products that are below the reorder level using OI BRWDesigner: 

You can use the OI BRWDesigner application to type the following script code directly into the VBScript Editor of 
the Detail section's OnPrint property. Complete the following steps: 

1. Select Detail from the Properties window drop-down list in the Designer. This reveals the section's available 
properties. 

2. Click the empty box next to the OnPrint property, then click the drop-down arrow, and select Script Editor 
from the list. 

3. In the VBScript Editor, simply type the following script in the window: 
If UnitsInStock < ReorderLevel Then  
BoxCtl.Visible = True 
Else 
BoxCtl.Visible = False 
End If 
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The following screen capture shows a section of the report with the special effects: 

 

 

Resetting	the	Page	Counter	
The Page variable is created and automatically updated by the control. It is useful for adding page numbers to page 
headers or footers. 

To reset the page counter when a group starts: 

In some cases, you may want to reset the page counter when a group starts. For example, in a report that groups 
records by country and has a calculated page footer field with the expression: 

=[Country] & " - Page " & [Page] 
 

Using OI BRWDesigner: 
To reset the page counter when a group (for example, a new country) starts, set the PageFooter field's Text 
property by completing the following steps: 

1. Select the PageFooter's PageNumber field from the Properties window drop-down list in the Designer. This 
reveals the field's available properties. 

2. Click the empty box next to the Text property, then click the drop-down arrow, and select Script Editor 
from the list. 

3. In the VBScript Editor, simply type the following script in the window: 
=[Country] & " - Page " & [Page] 

To reset the Page variable for each new country: 

It would be good to reset the Page variable for each new country. To do this, assign the following script to the 
Country Group Header section: 

Page = 1 
 

Using OI BRWDesigner: 
To reset the Page variable for each new country, set the Country Group Header OnPrint property by completing the 
following steps: 

1. Select the Country Group Header from the Properties window drop-down list in the Designer. This reveals 
the section's available properties. 

2. Click the empty box next to the OnPrint property, then click the drop-down arrow, and select Script Editor 
from the list. 
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3. In the VBScript Editor, simply type the following script in the window: 
Page = 1 

 

Changing	a	Field's	Dimensions	to	Create	a	Bar	Chart	
This is the most sophisticated example. Instead of showing a field's value as text, you can change its dimensions to 
create a chart. 

Create the Chart 

To create a chart, the first thing you need to do is find out the scale, that is, the measurements that will be used to 
the maximum and minimum values. The "Sales Chart" report has a field designed to do this. It is a report footer 
field called SaleAmountMaxFld that has the size of the longest bar you want to appear on the chart, and holds 
the following expression:  

=Max([SaleAmount]) 
 

Using OI BRWDesigner: 
To set the maximum value for the chart, set the SaleAmountMaxFld.Text property by completing the following 
steps: 

1. Select the SaleAmountMaxFld from the Properties window drop-down list in the Designer. This reveals the 
field's available properties. 

2. Click the empty box next to the Text property, then click the drop-down arrow, and select Script Editor 
from the list. 

3. In the VBScript Editor, simply type the following script in the window: 
=Max([SaleAmount]) 

Draw the Chart's Bars 

To draw the actual bars, the report has a detail field called BarFld that is formatted to look like a solid box. The 
Detail section has the following script assigned to its OnPrint property: 

BarFld.Width = SaleAmountMaxFld.Width * (SaleAmountFld / SaleAmountMaxFld) 

This expression calculates the width of the bar based on the width and value of the reference field and on the value 
of the SaleAmountFld for the current record. 

 

Using OI BRWDesigner: 
To draw the actual bars for the chart, set the OnPrint property by completing the following steps: 

1. Select Detail from the Properties window drop-down list in the Designer. This reveals the Detail section's 
available properties. 

2. Click the empty box next to the OnPrint property, then click the drop-down arrow, and select Script Editor 
from the list. 

3. In the VBScript Editor, simply type the following script in the window: 
BarFld.Width = SaleAmountMaxFld.Width * (SaleAmountFld / SaleAmountMaxFld) 

The following screen capture shows a section of the "Sales Chart" report with the special effects: 
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Working with OI BRWDesigner 
The following topics contain important information about OI BRWDesigner, a stand-alone application similar to 
the report designer in Microsoft Access, including how to create a basic report definition file, modify, print, and 
export the report definition. This section also demonstrates how to import reports created with Microsoft Access. 

 
About OI BRWDesigner 

Accessing OI BRWDesigner from Visual Studio 

Setting OI BRWDesigner Options 

Creating a Basic Report Definition 

Modifying the Report Layout 

Enhancing the Report with Fields 

Creating a Master-Detail Report Using Subreports 

Previewing and Printing a Report 

Exporting and Publishing a Report 

Managing Report Definition Files 

Importing Microsoft Access Reports 

Importing Crystal Reports 

Charting in Reports for WinForms 

 

About OI BRWDesigner 
The OI BRWDesigner application is a tool used for creating and editing OI BRW report definition files. The 
Designer allows you to create, edit, load, and save report files (stored internally in XML) that can be read by the OI 
BRW component. It also allows you to import report definitions from Microsoft Access files (MDB) and VSReport 1.0 
(VSR). 

 
The main Designer window has the following components: 
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•Application button: Click the application button to open a menu to load and save report definition files and 
to import and export report definitions. See Application Button for more information. 

•Design tab: Provides shortcuts to the Edit, Font, Data, Fields, and Tools menu functions. See Design Tab for 
more information. 

•Arrange tab: Provides shortcuts to the Edit, AutoFormat, Grid, Control Alignment, Position, and Size menu 
functions. See Arrange Tab for more information. 

•Page Setup tab: Provides shortcuts to the Edit and Page Layout menu functions. See Page Setup Tab for 
more information. 

•Preview tab: Appears only when the report is being viewed in a print preview. See Preview Tab for more 
information. 

•Help button: Provides options to open the online help file and view the About screen, which displays 
information about the application. 

•Reports tab: Lists all reports contained in the current report definition file. You can double-click a report 
name to preview or edit the report. You can also use the list to rename, copy, and delete reports. 

•Fields tab: Lists all the fields contained in the current report. 
•Properties tab: Allows you to edit properties for the objects that are selected in the Designer. 
•Pages tab: Only available when in preview mode, this tab includes thumbnails of all the pages in the 

document. 
•Properties tab: Only available when in preview mode, this tab displays a text outline of the document. 
•Find tab: Only available when in preview mode, this tab displays fine pane allowing you to search for text in 

the document. 
•Preview/Design pane: This is the main working area of the Designer. In preview mode, it displays the 

current report. In design mode, it shows the report's sections and fields and allows you to change the 
report definition. 

•Status bar: The status bar displays information about what the Designer is working on (for example, 
loading, saving, printing, rendering, importing, and so on). You can zoom in and out of a selected report 
by dragging the zoom slider at the right of the status bar. 

The topics that follow explain how you can use the OI BRWDesigner application to create, edit, use, and save 
report definition files. 

 
Application Button 

Design Tab 

Arrange Tab 

Page Setup Tab 

Preview Tab 

Style Gallery 

 
Application Button 
The Application button provides a shortcut menu to load and save report definition files and to import and export 
report definitions. You can also access the OI BRWDesigner application's options through the Application menu. 
Click the Application button to open the menu. It will appear similar to the following: 
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The menu includes the following options: 

•New: Creates a new report definition file. 
•Open: Brings up the Open Report Definition File dialog box, enabling you to select an existing file to 

open. 
•Close: Closes the current report definition file. 
•Save: Saves the report definition file, to the location previously saved.  
•Save As: Opens the Save Report Definition dialog box allowing you to save your report definition as an 

XML file. 
•Import: Opens the Import Report Definition dialog box enabling you to import Microsoft Access (.mdb 

and .adp) files and Crystal Reports (.rpt) files. See Importing Microsoft Access Reports and Importing 
Crystal Reports for more information. 

•Recent files: Lists recently opened report definition files. To reopen a file, select it from the list. 
•Options: Opens the OI BRWDesigner Options dialog box which allows you to customize the default 

appearance and behavior of the OI BRWDesigner application. See Setting OI BRWDesigner Options for 
more information. 

•Exit: Closes the OI BRWDesigner application. 

Design	Tab	
The Design tab is located in the OI BRWDesigner's Ribbon menu and provides shortcuts to the Edit, Font, Data, 
Fields, and Tools menu functions. For more information, see the following topics. 

 
Edit Group 

Font Group 

Data Group 

Fields Group 

Tools Group 
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Edit Group 
The Edit group on the Design tab appears similar to the following: 

 
It consists of the following options: 

•Preview: The Preview button opens a print preview view of the report. To exit the preview, click the Close 
Print Preview button. See Preview Tab and Previewing and Printing a Report for more information. 

•Paste: Pastes the last copied item. 
•Cut: Cuts the selected item, removing it from the report and allowing it to be pasted elsewhere. 
•Copy: Copies the selected item so that it can be pasted elsewhere. 
•Undo: Undoes the last change that was made to the report definition. 
•Redo: Redoes the last change that was made to the report definition. 

 

Font Group 
The Font group on the Design tab appears similar to the following: 

 
And consists of the following options: 

•Font Name: Displays the current font of the selected text and allows you to choose another font for the 
selected item (to do so, click the drop-down arrow next to the font name). 

•Font Size: Displays the current font size of the selected text and allows you to choose another font size. 
Type a number in the font size box or click the drop-down arrow to choose a font size. 

•Increase Font Size: Increases the font size by one point. 
•Decrease Font Size: Decreases the font size by one point. 
•Bold: Bold the selected text (you can also press CTRL+B). 
•Italic: Italicizes the selected text (you can also press CTRL+I). 
•Underline: Underlines the selected text (you can also press CTRL+U). 
•Left: Aligns text to the left. 
•Center: Aligns text to the center. 
•Right: Aligns text to the right. 
•Justify: Justifies the selected text. 
•Text Color: Allows you to select the color of the selected text. 
•Fill Color: Allows you to select the background color of the selected text. 

Data Group 
The Data group appears similar to the following image: 

 
And consists of the following items: 

•Sorting and grouping: Clicking this button opens the Sorting and Grouping dialog box where you can 
add and delete sorting and grouping criteria. For more information see Grouping Data and Sorting Data. 
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•Data Source: Clicking this button opens the Select a Data Source dialog box. The Select a Data Source 
dialog box allows you to choose a new data table for the report.  

 

 
To select change the connection string, click the ellipses button. This will open the Data Link Properties 
dialog box. To open an XML Schema Definition file (XDS) click the Open button (See Loading Data from 
an XSD File for more information). To edit or change the SQL statement, click the Build SQL Statement 
button which will open the Sql Builder dialog box. 

•Report Info: Opens the Report Information dialog box. This dialog box allows you to set the report's Title, 
Author, Subject, Creator, and Keywords. You can also choose to apply report information to all reports. 

 

Fields Group 
The Fields group of the Design tab in the OI BRWDesigner application provides tools for creating report fields. 
This toolbar is enabled only in design mode. The Fields group on the Design tab appears similar to the following: 

 
Each field button creates a field and initializes its properties. The Fields group consists of the following options: 

•Arrow: Returns the mouse cursor to an arrow cursor. 
•Data Field: Creates a field that is bound to the source recordset. When you click this button, a menu 

appears and you can select the recordset field. Bound fields are not limited to displaying raw data from 
the database. You can edit their Text property and use any VBScript expression. 

•Label: Creates a field that displays static text. 

•Add CheckBox ( ): Creates a bound field that displays a Boolean value as a check box. By default, the 
check box displays a regular check mark. You can change it into a radio button or cross mark by changing 
the value of the field's Checkbox property after it has been created. 

•Add BarCode ( ): Creates a field that displays a barcode. When you click this button, a menu appears 
where you can select other fields that are contained in the same report definition file to be displayed as a 
barcode. 

•Add Rtf Field ( ): Creates an RTF field. When you click this button, a menu appears where you can select 
other fields that are contained in the same report definition file to be displayed in RTF format. 
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•Add Calculated Field ( ): Creates a calculated field. When you click this button, the code editor dialog 
box appears so you can enter the VBScript expression whose value you want to display. 

•Add Common Calculated Field ( ): Creates a field with a commonly used expression. When you click this 
button, a menu appears and you can select expressions that render the date or time when the report was 
created or printed, the page number, page count, or "page n of m", or the report name. 

•Add Unbound Picture ( ): Creates a field that displays a static picture, such as a logo. When you click 
this button, a dialog box appears to prompt you for a picture file to insert in the report. A copy is made of 
the picture you select and placed in the same directory as the report file. You must distribute this file with 
the application unless you embed the report file in the application. When you embed a report file in your 
application, any unbound picture files are embedded too. 

•Add Bound Picture ( ): Creates a field that displays a picture (or object) stored in the recordset. When 
you click this button, a menu appears so you can select a picture field in the source recordset (if there is 
one; not all recordsets contain this type of field). 

•Add Line ( ): Creates a line. Lines are often used as separators. 

•Add Rectangle ( ): Creates a rectangle. Rectangles are often used to highlight groups of fields or to create 
tables and grids. 

•Add SubReport ( ): Creates a field that displays another report. When you click this button, a menu 
appears and you can select other reports that are contained in the same report definition file. See 
Creating a Master-Detail Report Using Subreports for more information. 

•Add Page Break ( ): Creates a field that inserts a page break. 

•Add Chart Field ( ):Creates a field that displays a chart. Unlike most bound fields, Chart fields display 
multiple values. To select the data you want to display, set the Chart field's Chart.DataX and 
Chart.DataY properties. To format the values along the X and Y axis, set the Chart.FormatX and 
Chart.FormatY properties. See Adding Chart Fields for more information. 

•Add Gradient Field ( ): Creates a gradient field. Gradients are often used as a background feature to 
make other fields stand out. See Adding Gradient Fields for more information. 

See Enhancing the Report with Fields for more information. For more information on adding fields to your report, 
see Creating Report Fields. 

 

Tools Group 
The Tools group on the Design tab appears similar to the following: 

 
It consists of the following options: 

•Property Grid: Selecting this item brings the Properties tab into view on the left pane. Note that you can 
also use F4 to view the Properties tab. 

•Field List: Selecting this item brings the Fields tab into view on the left pane. 
•Zoom: Allows you to select a value to set the zoom level of the report. 
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Arrange	Tab	
The Arrange tab is located in the OI BRWDesigner's Ribbon menu and provides shortcuts to the Edit, 
AutoFormat, Grid, Control Alignment, Position, and Size menu functions. See Edit Group for information about that 
group, and the following topics for the other groups. 

 
AutoFormat Group 

Grid Group 

Control Alignment Group 

Position Group 

Size Group 

 

AutoFormat Group 
The AutoFormat Group on the Arrange tab of the Ribbon appears similar to the following image: 

 
The AutoFormat group consists of the following options: 

•Styles: Opens the Report Style Editor dialog box, where you can choose a built-in style or create and edit 
your own custom style. 

•Apply Style: Applies style to the current selection. 
•As Table Row: Formats the current selection as a table row. 

Report Style Editor 

You can access the Report Style Editor dialog box by clicking the Styles button of the AutoFormat group. The 
Report Style Editor dialog box appears similar to the following image: 
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It includes several elements including: 

•Style Gallery List: The Style Gallery list displays all the currently available built-in and custom styles. See 
Style Gallery for information about the available built-in styles. 

•Add Button: The Add button adds a custom style to the Style Gallery list. The style that is added will be 
based on the style that was selected in the Style Gallery list when the Add button was clicked. 

•Remove Button: The Remove button removes a selected custom style. The button is only available when a 
custom style is selected in the Style Gallery list. 

•Property Grid: The Property grid lets you change the properties and edit a custom style. The Property grid 
is only available and editable when a custom style is selected in the Style Gallery list. 

•Preview Window: The Preview window displays a preview of the style selected in the Style Gallery list. 
•Apply Button: Clicking the Apply button applies the style to your selection without closing the dialog box. 
•OK Button: Clicking the OK button closes the dialog box, applies your changes, and sets the style you 

choose as the current selected style. 
•Cancel Button: Clicking the Cancel button allows you to cancel any changes you've made to styles. 

 

Grid Group 
The Grid group on the Arrange tab of the Ribbon appears similar to the following image: 

 
The Grid group consists of the following buttons: 

•Grid Properties: Opens the OI BRWDesigner Options dialog box. For details see Setting OI BRWDesigner 
Options. 
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•Snap to Grid: Snaps elements to the grid. When this item is selected elements cannot be placed in between 
lines of the grid. 

•Show Grid: Shows a grid in the background of the report in the preview. The grid can help you place and 
align elements. By default, this option is selected. 

•Lock Fields: After you've placed the fields in the desired positions, you can lock them to prevent 
inadvertently moving them with the mouse or keyboard. Use the Lock Fields button to lock and unlock 
the fields. 

 

Control Alignment Group 
The Control Alignment group on the Arrange tab of the Ribbon appears similar to the following image: 

 
The Control Alignment group consists of the following options: 

•Left: Horizontally aligns the selected item to the left. 
•Right: Horizontally aligns the selected item to the right. 
•Center: Horizontally aligns the selected item to the center. 
•Top: Vertically aligns the selected item to the top. 
•Bottom: Vertically aligns the selected item to the bottom. 
•Middle: Vertically aligns the selected item to the middle. 

Items can be both horizontally and vertically aligned – so, for example, an item can be both aligned to the left and 
the top. 

 

Position Group 
The Position group on the Arrange tab of the Ribbon controls spacing between elements and how elements are 
layered. It appears similar to the following image: 

 
The Position group consists of the following options: 

•Bring to Front: Brings the selected item to the front, in front of all layered items. 
•Send to Back: Sends the selected item to the back, behind all layered objects. 
•Equal Horizontal: Provides equal horizontal spacing between elements. 
•Increase Horizontal: Increases the horizontal spacing between elements. 
•Decrease Horizontal: Decreases the horizontal spacing between elements. 
•Equal Vertical: Provides equal vertical spacing between elements. 
•Increase Vertical: Increases the vertical spacing between elements. 
•Decrease Vertical: Decreases the vertical spacing between elements. 

 

Size Group 
The Size group on the Arrange tab of the Ribbon controls how elements are aligned and sized. It appears similar 
to the following image: 
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The Size group consists of the following options: 

•To Grid: Aligns the selected items to the grid. 
•To Tallest: Sets the height of all selected elements to the tallest selected item. 
•To Shortest: Sets the height of all selected items to the shortest selected item. 
•Size To Grid: Sizes the selected items to the grid. 
•To Widest: Sets the width of all selected items to the width of the widest selected item. 
•To Narrowest: Sets the width of all selected items to the width of the narrowest selected item. 

 

Page	Setup	Tab	
The Page Setup tab is located in the OI BRWDesigner's Ribbon menu and provides shortcuts to the Edit and 
Page Layout menu functions. See Edit Group and Page Layout Group for more information. 

 
Page Layout Group 

 

Page Layout Group 
The Page Layout group on the Page Setup tab of the Ribbon appears similar to the following image: 

 
The Page Layout group consists of the following options: 

•Portrait: Changes the layout of your report to Portrait view (where the height is longer than the width). 
•Landscape: Changes the layout of your report to Landscape view (where the height is shorter than the 

width). 
•Page Setup: Opens the printer’s Page Setup dialog box. 

 

Preview	Tab	
The Preview tab is located in the OI BRWDesigner's Ribbon menu and provides shortcuts to the Print, Page 
Layout, Zoom, Navigation, Tools, Export, and Close Preview menu functions. To access the Preview tab and a print 
preview of your report, click the Preview option located in the Edit group of the Ribbon. See Edit Group for more 
information. 
See Page Layout Group for information about that group, and the following topics for the other groups in the 
Preview tab. 

 
Print Group 

Zoom Group 

Navigation Group 

Tools Group 

Export Group 

Close Preview Group 
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Print Group 
The Print group on the Preview tab of the Ribbon appears similar to the following image: 

 
The Print group consists of the Print option. Clicking the Print option opens your printer options for printing the 
report. 

 

Zoom Group 
The Zoom group on the Preview tab of the Ribbon controls how the print preview is zoomed and appears similar 
to the following image: 

 
The Zoom group consists of the following options: 

•One page: Allows you to preview one page at a time. 
•Two pages: Allows you to preview two pages at a time. 
•More pages: Clicking the drop-down arrow allows you to preview multiple pages at a time and includes the 

following options: Four pages, Eight pages, Twelve pages. 
•Zoom: Zooms the page in to a specific percent or to fit in the window. 

 

Navigation Group 
The Navigation group on the Preview tab of the Ribbon controls how the print preview is navigated and appears 
similar to the following image: 

 
The Navigation group consists of the following options: 

•First page: Navigates to the first page of the preview. 
•Previous page: Navigates to the previous page of the preview. 
•Page: Entering a number in this textbox navigates the preview to that page. 
•Next page: Navigates to the next page of the preview. 
•Last page: Navigates to the last page of the preview. 
•History Back: Returns to the last page viewed. 
•History Next: Moves to the next page viewed. This is only visible after the History Back button is clicked. 

 

Tools Group 
The Tools group on the Preview tab of the Ribbon contains tools for selecting and locating items in the preview 
and appears similar to the following image: 
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The Tools group consists of the following buttons: 

•Hand Tool: The hand tool allows you to move the preview through a drag-and-drop operation. 
•Text Select Tool: The text select tool allows you to select text through a drag-and-drop operation. You can 

then copy and paste this text to another application. 
•Find: Clicking the Find option opens the Find pane where you can search for text in the document. To find 

text enter the text to find, choose search options (if any), and click Search: 

 
You can click a search result to locate it in the document. 

 

Export Group 
The Export group on the Preview tab of the Ribbon contains options for exporting the report to various formats 
and appears similar to the following image: 

 
Each item in the Export group opens the Export Report to File dialog box where you can choose a location for 
your exported file. The Export group consists of the following options: 

•Pdf: Exports the document to a PDF file. The drop-down arrow includes options for PDF (system fonts) and 
PDF (embedded fonts) to choose if you want to use system fronts or embed your chosen fonts in the 
PDF file. 

•Html: Exports the document to an HTML file. You can then copy and paste this text to another application. 
The drop-down arrow includes options for Plain HTML, Paged HTML, and Drilldown HTML allowing you 
to choose if you want to export to a plain HTML file, multiple HTML files that can be paged using included 
arrow links, or an HTML file that displays content that can be drilled down to. 

•Excel: Exports the document to a Microsoft Excel file. The drop-down arrow includes options for Microsoft 
Excel 97 and Microsoft Excel 2007 – OpenXML allowing you to choose if you want to save the 
document as an XLS or XLSX file. 

•Rtf: Exports the document to a Rich Text File (RTF). 
•Text: Exports the document to a Text file (TXT). 
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•More: Clicking the More drop-down arrow includes additional options to export the report including: Tagged 
Image File Format (export as TIFF), RTF (fixed positioning), Single Page Text, Compressed 
Metafile (export as ZIP). 

Note: When a document is exported to the RTF or the DOCX formats with the "preserve pagination" option 
selected, text is placed in text boxes and the ability to reflow text in the resulting document may be limited. 

 

Close Preview Group 
The Close Preview group on the Preview tab of the Ribbon appears similar to the following image: 

 
It includes just one button, Close Print Preview, enabling you to close the preview view and return to the design 
view. To return to the Review view again, click the Preview button in the Edit group. 

 

Style	Gallery	
The Style Gallery dialog box details all the available built-in and custom styles that you can use to format your 
report. Built-in styles include standard Microsoft AutoFormat themes, including Vista and Office 2007 themes. You 
can access the Style Gallery from the OI BRWDesigner application by selecting the Arrange tab and clicking 
Styles. 
The following built-in styles are included: 

Style Name Preview 

Access 2007 

 

Access 2003 

 

Apex 

 

Aspect 

 

Style Name Preview 

Oriel 

 

Origin 

 

Paper 

 

Solstice 
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Civic 

 

Concourse 

 

ComponentOne 

 

Equity 

 

Flow 

 

Foundry 

 

Median 

 

Technic 

 

Trek 

 

Urban 

 

Verve 

 

Windows Vista 

 

Bold 

 

Casual 
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Metro 

 

Module 

 

None 

 

Northwind 

 

Office 

 

Opulent 

 

 

Compact 

 

Corporate 

 

Formal 

 

Soft Gray 

 

Verdana 

 

WebReport 

 

 

Setting OI BRWDesigner Options 
To access the OI BRWDesigner Options dialog box, click the Application button and then Options. For more 
information about the Application button, see Application Button. The OI BRWDesigner Options dialog box 
appears similar to the following image: 
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The OI BRWDesigner Options dialog box includes options to control the appearance and behavior of the 
application. Options include: 

•Categorize property grid: Categorizes the Properties grid by property type. The Properties grid can be 
accessed by clicking the Properties tab located in the bottom of the left pane in Design view. 

•Filter field properties: Filters the Properties grid by properties that have been set. The Properties grid 
can be accessed by clicking the Properties tab located in the bottom of the left pane in Design view. 

•Enable undo/redo: Enables undo and redo in the application. 
•Sort report list: Sorts the list of reports listed on the Reports tab. Reports can be accessed by clicking 

the Reports tab located in the bottom of the left pane in Design view. 
•Show Grid: Shows the grid in the report preview window. 
•Snap to Grid: Snaps all objects the grid in the report. If this option is selected, you will not be able to 

place objects between grid lines. 
•Grid Units: Indicates how the grid is spaced. Options include Automatic, English (in), Metric (cm), 

and Custom. 
•Grid Spacing: Sets the spacing of grid lines. This option is only available when the Grid Units option is 

set to Custom. 
•Grid major color: Set the color of major grid lines. 
•Grid minor color: Sets the color of minor grid lines. 
•Field edges color: Sets the color of field edges in the report. 
•Show Subreport Content: Shows sub-report content in the report. 
•Reload last file on Startup: If this option is checked, the last opened file will appear whenever the OI 

BRWDesigner application is opened. 
•Embed images into Xml when saving: When the report is saved, images will be embedded into XML 

if this option is checked. 
•Save changes before rendering: Checking this option saves the report before rendering. 
•Save options when exporting: Checking this option saves the report's options when exporting. 
•Default Export Format: Sets the default export format. For more information about exporting see 

Export Group. 
•Auto Syntax Checking: Determines if syntax is automatically checked in the VBScript Editor dialog 

box. 
•Syntax Coloring: Determines if syntax text is automatically colored in the VBScript Editor dialog box. 
•Font: Defines the appearance of the text used in the VBScript Editor dialog box. 
•OK: Click OK to save your changes. 
•Cancel: Click Cancel to cancel any changes that you have made. 
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Creating a Basic Report Definition 
You can design your report to display your data in a variety of ways on the printed page. Using the OI 
BRWDesigner application, you can design comprehensive lists, summaries, or special subsets of data, like an 
invoice.  
The easiest way to start a new report is to use the OI BRW Wizard. In the OI BRW Wizard click the Application 
button and select New from the menu to create a new report. To access the OI BRW Wizard, click the New 
Report button from the Reports tab: 

 
 
 

Modifying the Report Layout 
The report generated for you by the wizard is a good starting point, but you will usually need to adjust and 
enhance it to get exactly what you want. You can do this with the OI BRWDesigner application. 
To start using the Designer, click the Close Print Preview button in the Close Preview group of the Preview 
tab: 

 
The right pane of the main window switches from Review mode into Design mode, and it shows the controls and 
fields that make up the report: 
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The picture shows how the report is divided into sections (Header, Page Header, Detail, and so on). The sections 
contain fields that hold the labels, variables, and expressions that you want in the printed report. In this example, 
the Header section contains a label with the report title. The Page Header section contains labels that identify the 
fields in the Detail section, and the Page Footer section contains fields that show the current time, the page 
number and the total page count for the report. 
The sections of the report determine what each page, group, and the beginning and end of the report look like. The 
following table describes where each section appears in the report and what it is typically used for: 

Section Appears Typically Contains 

Report Header Once per report The report title and summary information for the whole 
report. 

Page Header Once per page Labels that describe detail fields, and/or page numbers. 

Group Header Once per group Fields that identify the current group, and possibly 
aggregate values for the group (for example, total, 
percentage of the grand total). 

Detail Once per record Fields containing data from the source recordset. 

Group Footer Once per group Aggregate values for the group. 

Page Footer Once per page Page number, page count, date printed, report name. 

Report Footer Once per report Summary information for the whole report. 

Note that you cannot add and delete sections directly. The number of groups determines the number of sections in 
a report. Every report has exactly five fixed sections (Report Header/Footer, Page Header/Footer, and Detail) plus 
two sections per group (a Header and Footer). You can hide sections that you don't want to display by setting their 
Visible property to False. 
You can modify sections by changing their properties with the Properties window, or move and resize them with the 
mouse. 

Resizing a Section 
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To resize a section, select its border and with your mouse pointer drag to the position where you want it. The rulers 
on the left and on top of the design window show the size of each section (excluding the page margins). Note that 
you cannot make the section smaller than the height and width required to contain the fields in it. To reduce the 
size of a section beyond that, move or resize the fields in it first, then resize the Section. 
To see how this works, move the mouse to the area between the bottom of the Page Header section and the gray 
bar on top of the Detail Section. The mouse cursor changes to show that you are over the resizing area. Click the 
mouse and drag the line down until the section is about twice its original height.  

 
Release the mouse button and the section is resized. 
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Enhancing	the	Report	with	Fields	
To enhance your report, you can add fields (for example, lines, rectangles, labels, pictures, charts, and so on) to 
any Section. You can also modify the existing fields by changing their properties with the Properties window, or 
move and resize the fields with the mouse. 

Report Fields 

The Fields group of the Design tab in the OI BRWDesigner application provides tools for creating report fields. 
This toolbar is enabled only in design mode. Each button creates a field and initializes its properties. For more 
information about the Fields group, see Fields Group. For more information on adding fields to your report, see 
Creating Report Fields. 

 
Adding Chart Fields 

Adding Gradient Fields 

Selecting, Moving, and Copying Fields 

Changing Field, Section, and Report Properties 

Changing the Data Source 

 

Adding	Chart	Fields	
 
To add a Chart field to your report, complete the following steps: 

1. Open the report in the OI BRWDesigner application.  

2. Click the Add Chart Field button in the toolbar, and mark the area in the report where the Chart should 
be displayed.  

3. Then set the field properties as usual. 
The only unusual aspect of Chart fields is that unlike most bound fields, they display multiple values. To select the 
data you want to display, set the Chart field's Chart.DataX and Chart.DataY properties. To format the values 
along the X and Y axis, set the Chart.FormatX and Chart.FormatY properties. You can also customize the chart 
appearance by setting other properties such as Chart.ChartType, Chart.Palette, and so on. 
To create a new report with an embedded chart, use the OI BRW Wizard. Complete the following steps: 

1. Select the Tables radio button, and then select the Customers table. The following image shows this 
step: 
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2. Select the fields you want to display.  

This example groups the data by Country and show Company_Name and Invoice in the Detail section of 
the report: To add groups and detail fields, with your mouse pointer drag them from the Available list on 
the left to the Groups or Detail lists on the right: 
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Continue clicking Next until the wizard is done. The wizard creates the initial version of the report. 

3. Add the Chart to the Group Header section of the report. 
Charts usually make sense in the Group Header sections of a report, to summarize the information for the 
group. To add the chart to the Group Header section: 
a. Click the Close Print Preview button in the Close Preview group to switch to Design mode to begin 

editing the report. 
b. Expand the Group Header Section by performing a drag-and-drop operation with the section's borders. 

c. Then click the Add Chart Field button in the Fields group of the Design tab and place the field in 
the report in the Group Header Section. 

d. Resize the chart by clicking and dragging the chart field.  
e. From the Properties window, set the Chart.DataY property to the name of the field that contains the 

values to be charted, in this case, INVOICE_TOTAL.  
Note that the Chart.DataY property may specify more than one chart series. Just add as many fields 
or calculated expressions as you want, separating them with semicolons. 

f. Also set the Chart.DataX property to the name of the field that contains the labels for each data point, 
in this case, CUSTOMER_NAME. 

g. From the Properties window, set the Chart.FormatY property to "#,###" to set the values along the 
axis to thousand-separated values. 

h. In the properties window, also set the Chart.YLabelsAsStrings  to false, and Chart.RotateLabels to 
True, and set the Image.PictureScale to Scale.  

The Chart control will now display some sample data so you can see the effect of the properties that are 
currently set (the actual data is not available at design time). You may want to experiment changing the 
values of some properties such as Chart.ChartType, Chart.DataColor, and Chart.GridLines. You can 
also use the regular field properties such as Font and ForeColor. 
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Your report should look similar to the following report: 

Click the Preview button to see the report and click the Next page button to scroll through the report to 
view the Chart field for each group. The sample report should look like the following image: 
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Note that the Report field is sensitive to its position in the report. Because it is in a Group Header section, 
it only includes the data within that group. If you place the Chart field in a Detail section, it will include all 
the data for the entire report. This is not useful because there will be one chart in each Detail section and 
they will all look the same. If you need more control over what data should be displayed in the chart, you 
can use the DataSource property in the chart field itself. 
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Adding	Gradient	Fields	
Gradient fields are much simpler than charts. They are mainly useful as a background feature to make other fields 
stand out. 
The following image shows a report that uses gradient fields over the labels in the Group Header section: 

 
To create a similar gradient field, complete the following steps: 

1. In Design mode of the Designer, select the Add Gradient Field button from the Fields group in the 
Design tab. 

2. Move your mouse cursor (which has changed to a cross-hair) over the labels in the Group Header section 
and drag the field to the desired size. 

3. To ensure that the field is behind the labels, right-click the gradient field and select Send To Back. 
4. Then set the Gradient.ColorFrom and Gradient.ColorTo properties to SteelBlue and White, 

respectively. 
Note that you may change the angle of the gradient field by setting the Gradient.Angle property another value 
(default value is 0). 
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Selecting,	Moving,	and	Copying	Fields	
You can use the mouse to select fields in the OI BRWDesigner application as usual: 

•Click a field to select it. 
•Shift-click a field to toggle its selected state. 
•Control-drag creates a copy of the selected fields. 
•Click the empty area and drag your mouse pointer to select multiple fields. 
•With your mouse pointer, drag field corners to resize fields. 
•Double-click right or bottom field corners to auto size the field. 

To select fields that intersect vertical or horizontal regions of the report, click and drag the mouse on the rulers 
along the edges of the Designer. If fields are small or close together, it may be easier to select them by name. You 
can select fields and sections by picking them from the drop-down list above the Properties window. 

Show a grid 

The Snap to grid and Show grid buttons located in the Grid group in the Appearance tab provide a grid that 
helps position controls at discrete positions. While the grid is on, the top left corner of the fields will snap to the 
grid when you create or move fields. You can change the grid units (English or metric) by clicking the Application 
button and selecting Options from the menu. 

 

Lock fields 

After you have placed fields in the desired positions, you can lock them to prevent inadvertently moving them with 
the mouse or keyboard. Use the Lock Fields button to lock and unlock the fields. 

Format fields 

When multiple fields are selected, you can use the buttons on the Control Alignment, Position, and Size groups 
of the Appearance tab to align, resize, and space them. When you click any of these buttons, the last field in the 
selection is used as a reference and the settings are applied to the remaining fields in the selection. 

Apply styles 

 
The Apply Style to Selection button applies the style of the reference field to the entire selection. The style of a 
field includes all font, color, line, alignment, and margin properties. You can use the Properties window to set the 
value of individual properties to the entire selection. 

Determine order for overlapping fields 
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If some fields overlap, you can control their z-order using the Bring to Front/Send to Back buttons in the 
Position group. This determines which fields are rendered before (behind) the others. 

Move fields using the keyboard 

The OI BRWDesigner application also allows you to select and move fields using the keyboard: 
•Use the TAB key to select the next field. 
•Use SHIFT-TAB to select the previous field. 
•Use the arrow keys to move the selection one pixel at a time (or shift arrow to by 5 pixels). 
•Use the DELETE key to delete the selected fields. 
•When a single field is selected, you can type into it to set the Text property. 

 

Changing	Field,	Section,	and	Report	Properties	
Once an object is selected, you can use the Properties window to edit its properties. 
When one or more fields are selected, the Properties window shows property values that all fields have in common, 
and leaves the other properties blank. If no fields are selected and you click on a section (or on the bar above a 
section), the Section properties are displayed. If you click the gray area in the background, the Report properties 
are displayed. 
To see how this works, click the label in the Header section and change its Font and ForeColor properties. You can 
also change a field's position and dimensions by typing new values for the Left, Top, Width, and Height properties. 
The Properties window expresses all measurements in twips (the native unit used by OI BRW), but you can type in 
values in other units (in, cm, mm, pix, pt) and they will be automatically converted into twips. For example, if you 
set the field's Height property to 0.5in, the Properties window will convert it into 720 twips. 

 

Creating a Master-Detail Report Using Subreports 
Subreports are regular reports contained in a field in another report (the main report). Subreports are usually 
designed to display detail information based on a current value in the main report, in a master-detail scenario.  
In the following example, the main report contains categories and the subreport in the Detail section contains 
product details for the current category: 
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To create a master-detail report based on the Categories and Products tables, you need to create a Categories 
report (master view) and a Products report (details view). 

Step 1: Create the master report 

1. Create a basic report definition using the OI BRW Wizard. 
a. Select the Customers table from the  
b. Include the Customer_Name Company, City, Inv_Nos and Invoice_Total fields in the report. 

2. In the OI BRWDesigner application, click the Close Print Preview button to begin editing the report. 
3. Use the Properties window to change the Appearance settings (Font and ForeColor). Note that for this 

example, a Gradient field was added to the Detail Section. For information on Gradient fields, see 
Adding Gradient Fields. 

6. Select the Preview button, the Categories report should now look similar to the following image: 
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Step 2: Create the detail report 

1. In the OI BRWDesigner application, click the New Report button to create a basic report definition using 
the OI BRW Wizard. 
a. Select the Invoices table. 
b. Include the following fields in the report: Invoice_Date, and Due_Date. 

2. In the Report Designer, click the Close Print Preview button to begin editing the report. 
a. Set the Page Header and Header section's Visible property to False. 
b. In the Detail section, arrange the controls so that they are aligned with the heading labels. Use the 

Properties window to change the Appearance settings. 

Step 3: Create the subreport field 

The OI BRWDesigner application now has two separate reports, Customers Report and Invoices Report. The 
next step is to create a subreport: 

1. From the Reports list in the Designer, select Customer Report (master report). 
2. In design mode, from the click the Add Subreport button in the Fields group of the Design tab and select 

Invoices Report from the drop-down menu.  

 
3. In the Detail section of your report, click and drag the mouse pointer to make the field for the subreport: 
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Step 4: Link the subreport to the master report 

The master-detail relationship is controlled by the Text property of the subreport field. This property should contain 
an expression that evaluates into a filter condition that can be applied to the subreport data source. 
The Report Designer can build this expression automatically for you. Complete the following steps: 

1. Right-click the subreport field and select Link Subreport from the menu.  

 
2. A dialog box appears that allows you to select which fields should be linked.  
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3. Once you make a selection and click OK, the Report Designer builds the link expression and assigns it to the 

Text property of the subreport field. In this case, the expression is: 
"[CategoryID] = '" & [CategoryID] & "'" 

Alternatively, you can also link the subreport to the master report by completing the following steps: 
1. From the Properties window, click the Text property of the subreport field and select Script Editor from the 

drop-down list. 

 
2 . The Auto Generated Comment is used to populate the Link Subreport screen. In general, it is recommended 
that you only use the Link Subreport screen. 
3. Click OK to close the VBScript Editor and build the expression. 

 

Previewing and Printing a Report 
To preview a report, select the report to view from the Reports list on the left pane of the Designer window and 
click the Preview button, which appears on each Ribbon tab: 

 
Alternatively, you can select View | Preview from the menu. The report is displayed on the right pane, as shown 
in the following screen shot: 
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The main window has a preview navigation toolbar, with buttons that let you page through the document and 
select the zoom mode. 
At this point, you can print the report by clicking the Print button: 

 
 

Exporting and Publishing a Report 
Instead of printing the report, you may want to export it into a file and distribute it electronically to your clients or 
co-workers. The Designer supports the following export formats: 

Format Description 

Paged HMTL (*.htm) Creates one HTML file for each page in the report. The HTML pages 
contain links that let the user navigate the report. 

Drill-Down HTML (*.htm) Creates a single HTML file with sections that can be collapsed and 
expanded by the user by clicking on them. 

Plain HMTL (*.htm) Creates a single HTML file with no drill-down functionality. 
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PDF with system fonts 
(*.pdf) 

Creates a PDF file that can be viewed on any computer equipped with 
Adobe's Acrobat viewer or browser plug-ins. 

PDF with embedded fonts 
(*.pdf) 

Creates a PDF file with embedded font information for extra portability. 
This option significantly increases the size of the PDF file. 

RTF (*.rtf) Creates an RTF file that can be opened by most popular word processors 
(for example, Microsoft Word, WordPad). 

RTF with fixed positioning 
(*.rtf) 

Creates an RTF file with fixed positioning that can be opened by most 
popular word processors (for example, Microsoft Word, WordPad). 

Microsoft Excel 97 (*.xls) Creates an XLS file that can be opened by Microsoft Excel.  

Microsoft Excel 2007/2010 
Open XML (*.xlsx) 

Creates an XLS file that can be opened by Microsoft Excel 2007 and later.  

TIFF (*.tif) Creates a multi-page TIFF (Tag Image File Format) file. 

Text (*.txt) Creates a plain text file. 

Single Page Text (*.txt) Creates a single-page plain text file. 

Compressed Metafile (*.txt) Creates a compressed metafile text file. 

To create an export file, select File | Export from the menu and use the File Save dialog box to select the type of 
file you want to create, specifying its name and location. 
Note: When a document is exported to the RTF or the DOCX formats with the "preserve pagination" option 
selected, text is placed in text boxes and the ability to reflow text in the resulting document may be limited. 

 

XLATE	Support 
 
In the BRW Designer released with OpenInsight 9.3.1, a new “custom field” allows for the definition of an XLATE 
(file translate).  The XLate custom field is found in the upper-right corner of the BRW Designer, and has an icon of 
an “X” over an arrow: 
 

 
 
 
Once you select the Xlate custom field, your cursor should change to the crosshairs, and you should be able to 
draw the outline of the custom field on the form wherever you would like it to appear.  Once the custom field has 
been applied to the form, you must set its properties (found on the “Properties” tab): 
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The SourceTable property specifies what “foreign table” should be used as the source for the Xlate.  This can be a 
literal string indicating the name of the table, or a function that evaluates to the name of the table.  You can use 
the BRW Report Designer script editor to define this script, and can use any of the available fields, variables, or 
script functions to build the table name. 
 
The SourceKey property specifies what key should be used to access the record in the SourceTable.  This can be a 
literal string to use as the key, or a function that evaluates to a key in the table.  You can use the BRW Report 
Designer script editor to define this script, and can use any of the available fields, variables, or script functions to 
build the record key. 
 
The SourceField property defines which field should be returned from the record found in the SourceTable.  This 
can be a literal string (either a field number, or the name of a dictionary field in the SourceTable), or a function 
that evaluates to a field number or name.  You can use the BRW Report Designer script editor to define this script, 
and can use any of the available fields, variables, or script functions to build the field number or name.  Note that if 
SourceField evaluates to the null string (“”), the entire record is returned.  If any multivalues (or multiple fields) 
are returned by the Xlate, they will be converted to multiple lines of output on the form (you may need to set the 
CanGrow property to see these additional lines of output). 
 
The ErrBehavior property defines what should be returned if the Xlate function is unable to retrieve the desired 
data.  ReturnNullString (the default) will return a null string (“”) if the Xlate fails.  If ErrBehavior is set to 
ReturnKey,  the value of the SourceKey will instead by returned if the Xlate fails. 
 
In OpenInsight 10.0 and above there is a new property “ConversionCode” that is part of Xlate.  Just set that value 
to whatever OpenInsight conversion you want on your data: 
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Once the custom field is fully defined, it is drawn as a “placeholder” on the form: 
 

 
 
When the BRW report is run, the custom field properties are all evaluated (if they aren’t literal strings), and are 
passed to the host, where the XLATE is performed.  Your report will then include the output from the XLATE: 
 

 
 
 
Dynamic	Dictionaries 
 
In the BRW Designer released with OpenInsight 10.0, “dynamic” dictionary creation is now supported.  In the 
report definition, click on the Dynamic Dictionaries button: 
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Select either an existing dynamic field to edit, or ‘new field’ to define a New Field, in the Create/Edit Dynamic Field 
Definition form: 
 
 

 
 
Specify all the relevant definition information (for a calculated field, build the calculation; for a regular field 
definition, specify the field number; etc.) 
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Once saved, the dictionary is available in the list of table fields, and can be used in the report, in scripts, in groups, 
in the filter, etc. 
 

 
 
When run, the dynamic dictionary is created (using a unique temporary ID on the server) and runs just like a ‘real’ 
dictionary. 
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When the report is finished, the dynamic dictionary is cleaned up.  The dynamic dictionary that is created has the 
name _OIBRW_<guid> (e.g. _OIBRW_AS0AS82KASDF8292).  The dynamic dictionary information is stored in the 
report group.  Report groups with these changes will now be written with “v2” in field 1, and the dynamic 
dictionary information stored in field 2.  The same dynamic dictionary definition can be used for different reports in 
the same group, if they share the same table. 
 
Managing Report Definition Files 
A report definition file may contain several reports. Occasionally, you may want to copy or move a report from one 
file to another. 
To move a report from one file to another, open two instances of the OI BRWDesigner application and drag the 
report from one instance to the other. If you hold down the CTRL key while doing this, the report will be copied. 
Otherwise, it will be moved. 
You can also copy a report within a single file. This creates a new copy of the report, which is a good way to start 
designing a new report that is similar to an existing one. 
Note that the report definition files are saved in XML, so you can also edit and maintain them using any text editor. 

 

 

Importing Crystal Reports 
The OI BRWDesigner application can also import Crystal report definition files (.rpt files). 
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To import reports from a Crystal report definition file: 

1. Click the Application button and select Import from the menu.  
A dialog box prompts you for the name of the file you want to import. 

2. Select a Crystal report definition file (RPT) and the Designer will convert the report into the OI BRW format. 
The import process handles most elements of the source reports, with a few exceptions for elements that are not 
exposed by the Crystal object model or not supported by OI BRW. The exceptions include image fields, charts, and 
cross-tab fields. 

 

Charting in Reports 
In the following topics, you'll see how you can customize chart fields in reports using the OI BRWDesigner 
application. 

 
Charts in Flat Reports 

Other Useful Chart Properties 

Charts with Multiple Series 

Series with Calculated Values 

Charts in Grouped Reports 

Aggregate Charts 

 

Charts	in	Flat	Reports	
Creating simple charts is very easy. The following steps required to create a simple chart: 

1. Open the OI BRWDesigner application and create or open a report definition file. 
2. Add a Chart field to the report, then select it to show its properties in the designer's property window. 
3. Set the chart's DataX property to the name of the field whose values should be displayed in the X axis 

(chart categories). 
4. Set the chart's DataY property to the name of the field whose values should be displayed in the Y axis 

(chart values). 
5. Optionally set additional properties such as ChartType and DataColor. 
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For example, the chart below was created based on the Products table. In this case, the following properties were 
set: 
DataX = "ProductName" 
DataY = "UnitPrice" 

 
Note that for this chart type (Bar), the value axis (where the DataY field is displayed) is the horizontal one, and 
the category axis (where the DataX values are displayed) is the vertical one. 
In this case, a filter was applied to the data in order to limit the number of values shown. Without the filter, the 
chart would contain too many values and the vertical axis would not be readable. 

Other	Useful	Chart	Properties	
In addition to the DataX and DataY properties mentioned above, the Chart object provides a few other properties 
that are commonly used: 

•ChartType: This property allows you to select the type of chart to display. There are six options: Bar 
(horizontal bars), Column (vertical columns), Scatter (X-Y values), Line, Area, and Pie. 

•DataColor: This property selects the color used to draw the bars, columns, areas, scatter symbols, and pie 
slices. If the chart contains multiple series, then the Chart field automatically generates different shades 
of the selected color for each series. If you want to select specific colors for each series, use the Palette 
property instead, and set its value to a semi-colon separated list containing the colors to use (for example 
"Red;Green;Blue"). 

•FormatY, FormatX: These properties determine the format used to display the values along each axis. For 
example, setting FormatY to "c" causes the Chart field to format the values along the Y axis as currency 
values. This is analogous to the Format property in regular report fields. 

•XMin, XMax, YMin, YMax: These properties allow you to specify ranges for each axis. Setting any of them 
to -1 cause the Chart to calculate the range automatically. For example, if you set the YMax property to 
100, then any values higher than 100 will be truncated and won't appear on the chart. 

These properties apply to all chart types. There are a few additional properties that only apply to Pie charts: 
•ShowPercentages: Each pie slice has a legend that shows the X value for the slice. If the 

ShowPercentages property is set to true, the legend will also include a percentage value that indicates 
the size of the slice with respect to the pie. The percentage is formatted using the value specified by the 
FormatY property. For example, if you set FormatY to "p2", then the legends will include the X value 
and the percentage with two decimal points (for example "North Region (15.23%)"). 

•RadialLabels: This property specifies that instead of showing a legend on the right side of the chart, labels 
with connecting lines should be attached to each slice. This works well for pies with few slices (up to about 
ten). 

The Chart field is actually a wrapper for a C1Chart control, which provides all the charting services and has an 
extremely rich object model of its own. If you want to customize the Chart field even further, you can use the 
ChartControl property to access the inner C1Chart object using scripts. 
For example, the Chart field does not have a property to control the position of the legend. But the C1Chart 
control does, and you can access this property through the ChartControl property. For example, the script below 
causes the chart legend to be positioned below the chart instead of on the right: 

' place legend below the chart 
chartField.ChartControl.Legend.Compass = "South" 

If you assign this script to the report's OnLoad property, the chart will look like the image below: 
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The other properties used to create these chart are as follows: 
ChartType = Pie 
FormatY = "p1" 
ShowPercentage = true 
Palette = "Red;Gold;Orange;Beige;DarkGoldenrod;Goldenrod;" 

 

Charts	with	Multiple	Series	
To create charts with multiple series, simply set the DataY property to a string that contains the names of each 
data field you want to chart, separated by semi-colons. 
For example, to create a chart showing product prices and discounts you would set the DataY property as shown 
below: 
DataY = "UnitPrice;Discount" 
If you want to specify the color used to display each series, set the Palette property to a list of colors separated by 
semi-colons. For example, the value displayed below would cause the chart to show the UnitPrice" series in red and 
the "Discount" series in blue: 
Palette = "Red;Blue" 

 

Series	with	Calculated	Values	
The DataY property is not restricted to field names. The strings that specify the series are actually treated as full 
expressions, and are calculated like any regular field in the report. 
For example, to create a chart showing the actual price of each field you could set the DataY property to the value 
shown below: 
DataY = "UnitPrice * (1 - Discount)" 
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Charts	in	Grouped	Reports	
OI BRW allows you to create reports with multiple groups. For example, instead of listing all products in a single 
flat report, you could group products by category. Each group has a header and a footer section that allow you to 
display information about the group, including titles and subtotals, for example. 
If you add a chart to a group header, the chart will display only the data for the current group. By contrast, adding 
a chart to the report header or footer would include all the data in the report. 
To illustrate this, here is a diagram depicting a report definition as shown in the report designer and showing the 
effect of adding a Chart field to the report header and to a group header: 

Report Header section  
A chart field here would generate 
only one chart for the entire report. 
 
The chart would show all the data 
in the report's data source. 

Page Header section 

Group Header section (CategoryName)  
A chart field here would generate 
one chart for each CategoryName value. 
 
Each chart would show all the data 
for the current CategoryName. 

Detail section 

Group Footer section (CategoryName) 

Page Footer section 

Report Footer section 

Continuing with the example mentioned above, if you added a chart to the group header and set the DataX 
property to "ProductName" and the DataY property to "UnitPrice", the final report would contain one chart for each 
category, and each chart would display the unit prices for the products in that category. 
The images below show screenshots of the report described above with the group headers, the charts they contain, 
and a few detail records to illustrate: 
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The above chart shows unit prices for products in the "Beverages" category. The below chart shows unit prices for 
products in the "Condiments" category. 

 
DataX = "Product Name" 
DataY = "Unit Price" 
Because the chart automatically selects the data based on the scope of the section that contains it, creating charts 
in grouped reports is very easy. 
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Aggregate	Charts	
The Chart field included with the OI BRW has a powerful new feature called "aggregated charting". This feature 
allows you to create charts that automatically aggregate data values (DataY) that have the same category 
(DataX) using an aggregate function of your choice (sum, average, standard deviation, and so on). 
To illustrate this feature, consider an "Invoices" report that groups data by country, customer, and order ID. The 
general outline for the report is as follows: 

Report Header section 

Page Header section 

Group Header section (Country) 

Group Header section (Customer) 

Group Header section (OrderID) 

Detail section 

Group Footer section (OrderID) 

Group Footer section (Customer) 

Group Footer section (Country) 

Page Footer section 

Report Footer section 

Now imagine that you would like to add a chart to each Country header displaying the total value of all orders 
placed by each customer in the current country. 
You would start you adding a Chart field to the "Country" header section and set the DataX and DataY properties 
as follows: 
DataX = "CustomerName" 
DataY = "ExtendedPrice" 
This would not work. The data for each country usually includes several records for each customer, and the chart 
would create one data point for each record. The chart would not be able to guess you really want to add the 
values for each customer into a single data point. 
To address this scenario, we added an Aggregate property to the Chart field. This property tells the chart how to 
aggregate values that have the same category into a single point in the chart. The Aggregate property can be set 
to perform any of the common aggregation functions on the data: sum, average, count, maximum, minimum, 
standard deviation, and variance. 
Continuing with our example, we can now simply set the chart's Aggregate property to "Sum". This will cause the 
chart to add all "ExtendedPrice" values for records that belong to the same customer into a single data point. The 
result is shown below: 
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Notice how each customer appears only once. The values shown on the chart correspond to the sum of the 
"ExtendedPrice" values for all fields with the same "Customer". 
Because the chart appears in the "Country" header field, it is repeated for each country, showing all the customers 
in that country. 
If you place the chart in the report header section, it will aggregate data over the entire report. For example, 
suppose you want to start the "Invoices" report with a chart that shows the total amount ordered by each 
salesperson. To accomplish this, you would add a Chart field to the report header section and would set the 
following properties: 
DataX = "Salesperson" 
DataY = "ExtendedPrice" 
Aggregate = "Sum" 
The image below shows the resulting chart: 

 
Since the chart is placed in the report header section, the values displayed include all countries and all customers. 
If you moved the chart field from the report header to the "Country" group header, you would obtain a similar 
chart for each country, showing the total amounts sold by each salesperson in that country. 
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Command line interface for the OI BRW 
 
To start up the Banded Report designer, you can do the following: 
 
CALL RTI_BRWSUPPORT("LAUNCH") 
 
Once you have your report(s) defined, you can generate them programmatically using the following: 
 
CALL RTI_BRW_GENERATEREPORT(rptFile, rptName, outputName, rptType, overrideListID, rptDetails, bUseGUI) 
 
where rptFile is the name of the report group you saved the desired report(s) into and rptName is the name of the 
specific report to run (or "*" to run all the reports in the group). You may also specify a semicolon-delimited list of 
report names if desired. 
 
OutputName is the path and name of the file to save the output to (if producing a PDF, HTM, etc. document) - 
leave this blank to generate printed output. 
 
rptType is the type of output to generate, and can be PDF, TIFF, HTML, TEXT, XLS, or XLSX (or PRINT to generate 
printed output, but that isn't really needed if you leave outputName blank). 
 
overrideListID is the ID of a saved list that contains the record keys you want this report generation to use. If there 
is no overrideListID specified, but there is an active select list when RTI_BRW_GENERATEREPORT is called, then 
the active list will be used instead. 
 
rptDetails is only used when the rptType is PDF - if desired, you can specify in rptDetails the access permissions for 
the PDF, and the password(s) for PDF access. 
 
bUseGUI is a flag that indicates whether you want report generation to occur with a GUI (set bUseGUI to "1") or 
without a GUI, ie, silently (set bUseGUI to "0"). Note that if the output is going to the printer, you can also set 
bUseGUI to "2" - in this case, you'll get a full print preview window, instead of just a printer control window as you 
would if bUseGUI is "1". Note that the default if bUseGUI is not specified is "0" (no GUI). 
 
You can also call, during SET_PRINTER, the LOADREPORT call; this will "embed" generated BRW output into OIPI 
output (this is only available when using VSPRINTER2, aka OIPI.NET). You'll pass in to the SET_PRINTER call the 
name of the report group, the name of the report to include ("*" for all in the group, or a semicolon-delimited list), 
the overrideListName, and a flag (0/1) to indicate whether the BRW report is appended to the current output (1) or 
replaces the current output (0). 
 
Note that in both cases (LOADREPORT in OIPI.NET, or RTI_BRW_GENERATEREPORT) you can if desired pass in a 
full report definition (which is just an XML string) in the "report group" parameter. In this way, you can actually 
access the report definition and modify it, or create one entirely programmatically. 
 
If this is something you wish to do, you can use the following to read an existing report definition: 
 
rptdef = RTI_BRWSUPPORT("READ", reportGroupName, bLockFlag) 
 
where reportGroupName is the name of the report group, and bLockFlag is a flag to indicate whether the record 
should be locked (1) or left unlocked (0). 
 
By default, the RTI_BRW_GENERATEREPORT routine can generate one or more documents of the same output type 
(PDF, print, XLS, etc.) that are all contained in a single report group.  For example, to invoke 
RTI_BRW_GENERATEREPORT to build a PDF based on the report “Sample Report” in the report group “SAMPLES”: 
 
DECLARE FUNCTION RTI_BRW_GENERATEREPORT 
reportGroup = “SAMPLES” 
reportName = “Sample Report” 
outputName = “C:\TEMP\OUTPUT.PDF” 
reportType = “PDF” 
bUseGUI = “0” 
rslt = RTI_BRW_GENERATEREPORT(reportGroup, reportName, outputName, reportType, ‘’, ‘’, bUseGUI) 
 
If you wish to build multiple reports (contained in the same report group) of the same output type, multiple report 
names can be specified in a single request, using the semicolon delimiter.  For example, to build a PDF based on 
the reports “Sample Report” and “Example Output”, both contained in the “SAMPLES” report group: 
 
DECLARE FUNCTION RTI_BRW_GENERATEREPORT 
reportGroup = “SAMPLES” 
reportName = “Sample Report;Example Output” 
outputName = “C:\TEMP\OUTPUT.PDF” 
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reportType = “PDF” 
bUseGUI = “0” 
rslt = RTI_BRW_GENERATEREPORT(reportGroup, reportName, outputName, reportType, ‘’, ‘’, bUseGUI) 
 
If you wish to generate multiple different output types (for example, both PDF and print output) or output from 
different report groups, these can also be created with a single call to RTI_BRW_GENERATEREPORT by using the 
record mark delimiter (@RM) to delimit each report file, report name collection, output name, report type, override 
list name, and GUI flag.  
 
For example, to build a PDF based on the report “Sample Report” in the report group “SAMPLES”, and an on-screen 
display of the report “Display Report” in the report group “DISPLAYS”: 
 
DECLARE FUNCTION RTI_BRW_GENERATEREPORT 
reportGroup = “SAMPLES”:@rm:”DISPLAYS” 
reportName = “Sample Report”:@rm:”Display Report” 
outputName = “C:\TEMP\OUTPUT.PDF”:@rm:”” 
reportType = “PDF”:@rm:”PRINT” 
bUseGUI = “0”:@rm:”2” 
rslt = RTI_BRW_GENERATEREPORT(reportGroup, reportName, outputName, reportType, ‘’, ‘’, bUseGUI) 
 
 
As seen in the above examples, the RTI_BRW_GENERATEREPORT stored procedure is a function that can return a 
status value so the developer can determine the results from the request.  Note that many of the available status 
values (and the parameter modifications, described below) will only be set when the BRW is configured to use a 
new engine to generate its output; when configured to ‘share’ the current engine (the default), most of these 
values will not be returned. 
 
The return values are: 
 
0: success 
-1: Either parameter “reportFile” or “reportName” is null (“”) 
1: Report definition is null – specified report is not on file 
                2: unable to open SYSLISTS table 
<error text> : error returned by call to the BRW component 
<ole status>: error returned by call to the BRW component 
 
In addition, the RTI_BRW_GENERATEREPORT routine may modify the passed-in parameters for “reportName” and 
“outputName”.  If multiple reports are specified in the reportName parameter (either by using the “*” wildcard, or 
explicitly by using multiple report names separated by semicolons (“;”)), when the RTI_BRW_GENERATEREPORT 
completes, the reportName parameter will be changed to a full list of all the individual report names that were 
accessed (@VM delimited), and the outputName parameter will be changed to a full list of all the individual output 
files that were generated (one per report name), @VM delimited. 
 
RTI_BRWSUPPORT is a handy function with a few different actions. We've already discussed LAUNCH and READ; 
you can also call it with the following actions: 
 
DISPLAY: pass in the report group name and specific report name (in parameters 2 and 3) and the report will be 
displayed via OIPI.NET; 
 
REPORTS: this will return, as the result of the function call, an @VM delimited list of the report groups defined for 
your application 
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